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1 Introduction 
This User Reference provides a definition of all available commands, views, options. 

To understand PedX further, it should be explained that PedX can be accessed through eight different 
views: 

• Grid view - this provides a spreadsheet style interface and is useful for seeing lots of data at the same 
time. 

• Single view - this a view of one record only with the fields split into groups accessible via tabs. It 
provides much large edit boxes for editing the fields and is useful for viewing and editing photos and 
comments or notes 

• Pedigree view – this is used for display the Pedigree Chart and Descendants Chart. 

• Data Design view - this provides a spreadsheet style interface for modifying or adding fields. 

• Report view – a text report view that provides reports like 9 gen pedigrees and breeding reports grouped 
by mating. 

• Form view - this will present the database data in a pre-designed form, e.g. pedigree certificate or family 
tree. 

• Form Design view (also referred to as forms edit view) - this allows the user to modify or create new 
forms. 

• Event view – this provides error and event messages for some operations such as self parenting errors 
during inbreeding calculations. 

This User Reference divides the commands for all views into common sections which are named after the 
menu heading. 

The names of the menu headings and therefore sections are as follows: 

File - Describes commands for creating new files, reading existing files, saving files,  importing and 
merging files. 

Edit - Lists commands for copy, paste, cut, deleting and creating records, cells, drawing  entities (e.g. 
lines, text). 

Search - (database view only) - Commands for searching the database and also find and   
   replace. 

Mark  - Commands for marking the records in the database. 

Table- (data design view only)  - Commands for creating tables within the database and   
              naming them, deleting them, renaming them and selecting                
them. 

Tools- (grid view only)  - Import and Export commands. 

Form - (form view only) - Commands for creating forms within the forms file and naming   
      them, deleting them, renaming them and selecting them. 

Format (design view only) - change properties of various drawing objects such as text, rectangles etc. 

View -  Commands which affect the way in which the data is viewed, e.g. zoom. 

Window - Commands which affect all the windows within PedX, e.g. tiling windows. 

Help -  Help and about commands. 
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2 Database Basics 
PedX is a proprietary database program designed specifically for fast operation, minimum memory 
requirements and small disk size. 

All PedX database files end with a “.bmx” extension (form files end in FMX and are used for display 
purposes only). Any single file usually contains all the data for a given breed of animal and any number of 
files can be maintained. For example you could keep all your Papillon records in a file called 
“papillon.bmx” and keep Afghan records in a file called “afghan.bmx” etc. 

Like all relational databases, PedX divides its database files into “tables” where each table consists of rows 
and columns of data of related information, e.g. a pedigree table or a show table. 

Each row is called a record or “entry” and each column is a field. A field in any particular record is called a 
cell. The first field in each table is special and is called the primary key, e.g. in the ‘Pedigree’ table the 
name of the entry is the primary key. The primary key must be unique and for this reason all entries must 
have a unique name. 

PedX allows you to add records or modify them at any time – there are no restrictions. There are, however, 
some nominal limits which have been set on various sizes as follows: 

• Each file is nominally limited to 127 tables – normally you will only use the predefined tables anyway. 

• Each database can contain at least 500,000 records (limited only by available RAM). 

• Each record can contain up to 127 fields and a total of 32,000 (2000 in V3.0) characters. 

• Each field can contain up to 32,000  characters. 

• A field can be one of four basic types of data, text, date, number, currency. Within each data type 
there are display types, e.g. dates can be displayed as dd/mm/yyyy or mm/dd/yyyy. 

A PedX file will always contain at least one table – this is called the Pedigree table. This table contains a 
record for each of the animals in the database.  

The data in the fields is case insensitive, i.e. it does not matter whether you enter data in upper or lower or 
mixed case. 

Note that spaces are important when attempting to match the sire field of one entry against the name field 
of another entry. If they differ by one or more space characters inserted at the beginning, end or somewhere 
in the middle of the names then the match will fail. This would, for example, mean that a family tree or 
pedigree cannot be constructed. 

PedX has a special function which strips extra spaces out of any data which is manually entered - thus 
hopefully avoiding mistyping errors. This feature can be disabled via View-Options. 

As mentioned previously, a PedX file can contain more than one table. Apart from the tables mentioned in 
Section 17 ' Database Tables', all the other tables have, at this stage, no special meaning to PedX, but 
should be considered reserved for future use. 

 



 Pedigree Explorer 6.0 User Reference 

 3

3 User Interface 
The main elements of the user interface are shown in Figure 3.1. 

Figure 3.1 

 

 

  
 

 

The elements are: 

• Title bar – in the example above it is the area at the top of the window containing the text “PedX – 
[SAMPLE.BMX]”. 

• Menu bar – contains the names of the menu headings,  
“File    Edit     Search     Mark     Tools     View     Window     Help”. 

• Browser bar – this is the two large left and right arrow buttons, combo and other buttons immediately 
below the menu bar. 

• Status bar – this is located at the bottom of the window. It displays messages such as a description of 
the function of the current selected menu command. Part of the status bar, on the right hand side will 
also display the entry at the top of the database view when the vertical scroll button is dragged. 

• Chooser bar – occupies most of the left side of the screen when docked. Double click on its title bar to 
float it. It can be dragged and resized using the mouse. 

Maximise and minimise 
buttons 

Tool bar Browser bar Menu bar 

View 
Vertical Scroll 
bar 

ComboBox 

Horizontal 
Scroll bar Status bar Chooser bar 
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• Dialog bar – located immediately below the toolbar. It also contains the Edit Box and Add Record, 
Find buttons. 

• Combobox (part of Dialog Bar) – this is where any text is entered either to add or modify data in the 
database or for searches and mark functions (except Find Replace). If the field you have currently 
selected is "linked" (e.g. sires and dams are linked to the names in the Pedigree table) then the 
ComboBox will display a "drop down" button. When you click on this button you will get a list of 
choices - hence for sire or dam it will list all names in the Pedigree table. Double click on a list item or 
click on it once and hit Enter to put that data in the current field. 

• Horizontal and vertical scroll bars. 

• Coordinates - in the database view this will show the entry that would appear at the top of the view 
when the vertical scroll button is being dragged. In forms view it shows the X and Y location of the 
mouse with respect to the origin. The origin by default is the top left of a form, but this can be 
changed by using the View-Set Origin command. 

• View – this is the rectangular area bounded by the scroll bars and the dialog bar. It is used to display a 
view of the database, family tree or pedigree. 

3.1 Title Bar 

The title bar displays the name of the database file in square brackets. As shown in Figure 3.1 this would be 
“sample.bmx”. The title bar can be used to reposition the whole window on the screen by clicking on it and 
dragging. You can also alternately maximise and minimise the window by double clicking on it. 

3.2 Menu Bar 

Most commands are available from the menu bar. Commands are grouped under menu headings. To see the 
commands under a particular heading, select a heading by clicking the left mouse button while the cursor is 
on it – all the commands under that heading are then displayed. Any one of the displayed commands can 
then be executed by clicking on it. Note that the menu headings and menu items will vary depending on 
what view you are in, e.g. from the pedigree view, no mark commands are available. 

Some of the commands are also accessible from the keyboard in either one or two different ways. The first 
method is to hit the Alt key and then hit the first letter of the menu heading, e.g. to display the File menu, 
hit Alt and then the “f” key. Next hit the key for the letter which is underlined in the command, e.g. under 
the File menu the save command appears as “Save”, so to execute it from the keyboard the complete 
sequence of keystrokes is Alt, “f”, “s”. Note the Alt key does not need to be kept pressed. 

The second method of accessing some commands is to enter the keystroke which is displayed next to the 
menu item, e.g. the Add Record command can be executed simply by hitting the F5 key. 

Menu commands are sometimes referred to as Menu-Command, for example, the Add Entry command on 
the Edit menu would be referred to as Edit-Add Record. 

3.3 Status Bar 

This is the area of the window at the bottom. It is used principally to print a message describing commands 
as they are selected from the menu or tool bar. A simple way of finding what each menu command is, is to 
select it from the menu by keeping the left mouse button pressed – when you have finished reading the 
command description, pull the cursor away until no commands are selected then release the mouse button. 
This also works with tool bar buttons – just place the cursor above the button, press the left mouse button 
then pull the mouse away from the button before releasing – this will still print a description of the 
command in the status bar but will not activate the command. 

The right hand side of the status bar is also used in the database view to display the name of the entry at the 
top of the view when the vertical scroll button is being dragged. This allows rapid scrolling to a desired 
area in the database. 
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3.4 Views 

The information in a database file can be viewed in the following ways: 

• Grid view 

• Single view 

• Forms view 

• Pedigree view 

• Data Design view 

• Form Design view 

• Merge Manager 

• Data Doctor 

The Grid view is similar to a spreadsheet where each entry is a row and each item of information for that 
entry appears in a separate column. Note that entries are always listed in the alphabetic order of the entry’s 
name. 

The form view shows the currently selected entry on the currently selected form. It does not show all the 
information that the database view does. 

The design view allows the user to edit forms or create new forms. 

Now for all these views the following rules apply: 

• Any view can be printed or you can print preview it. 

• Fields can be selected in the database and forms views by simply clicking on a particular field with the 
left mouse button. The field will then be highlighted in yellow. Once a field is highlighted, it can be 
updated by editing the text in the edit box and hitting Enter. 

• The user can switch views at any time by selecting any of the view tool bar buttons. 

• In the database view you can go to the form (e.g. pedigree) of an entry by double clicking on it. 

3.5 Minimise / Maximise Buttons 

Clicking on the maximise button (up arrow) – or double clicking in the Title Bar – will resize the PedX 
window to fill the whole screen. This button will then change to an up and down arrow symbol and when 
the user clicks on it again, it will restore the PedX window to the size it was before it was maximised 

Clicking on the minimise button will make PedX an icon on the desktop. To restore PedX, select “Restore” 
from the menu accessed by clicking the icon. 

The overall PedX window size can be adjusted by clicking in the resizing bars and dragging. Note that the 
cursor changes to a double headed arrow when it is above the resizing bar. 

PedX remembers the size and position of its window and will restore it each time the program is started. It 
also remembers the last database opened and will automatically open this for you when you start the 
program. 

Name in status 
bar changes 
when dragging 
scroll button 
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3.6 Scroll bars 

Most of the views will not fit entirely in the PedX window, hence PedX allows you to scroll (pan) around 
the view by using the scroll bars. The vertical scroll bar will move the view vertically and similarly for the 
horizontal scroll bar. 

When the scroll button is dragged, the view will only pan to a given position when the button is released. In 
the database view, the entry which would appear at the top of the view (if the mouse button was released) is 
displayed in the status bar when the vertical scroll button is being dragged. 

3.7 Chooser Bar 

The Chooser Bar provides a convenient grouping of forms, tools or tables. Click on a table to see it in Grid 
view, or click on any form to see the currently selected record in that form.  

 
The groups are as follows: 

• Database - this group lists all of your database tables under Table heading and a Lookup heading 
which is for tables whioch contain lookup data such as colors, titles, sex. 

• Forms - Dialogs - dialog style forms used for entering data 
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• Forms -Pedigrees - lists all the forms related to pedigrees 

• Forms -Shows - lists show entry forms etc 

• Forms -Breeding - lists all forms related to other breeding activities, e.g. studbook, litter record 

• Forms -Reports - text and HTML reports 

• Tools - Ped Chart – Pedigree chart provides a large pedigree chart potentially showing up to 40 
generations with repeat ancestors removed. 

 

3.8 Regions 

From the database view it is possible to select a region of cells rather than just a single cell. A region is 
defined as a rectangular area encompassing a range of entries and fields. 

To select a single cell, move the cursor above the cell and click the left mouse button. To select a region 
you first select a cell at one corner of the region (say top left) and then select the diagonally opposite cell in 
the region but with the shift key pressed. The entire region will now be highlighted in yellow. An example 
of a region is shown below in Figure 3.2 with a dotted rectangle. This region could have been selected by 
clicking on the name Almondene Barandale Heather then, holding the Shift key down, clicking on the 
DOB field of the “Almondene Black Beauty” entry. 

 

Figure 3.2 

There are a number of shortcuts for selecting regions as shown in Figure 3.2. The short cuts in detail are as 
follows: 

• An entire entry (row) can be quickly selected by clicking in the index field (the very left most field of 
the view that shows the entry’s index in the database. 

• An entire column can be selected by clicking on the field heading. 

• The entire database can be selected by clicking in the ‘corner’, i.e. the cell in the top left of the view. 

• Large regions can be constructed by selecting a region as indicated above, and then holding the shift key 
and selecting another region. The result will always be a rectangular region. 

Regions have a number of uses as follows: 

• Rather than printing the whole database, a range of entries in the database view can be printed by 
selecting the region of interest and choosing Selection from the Print dialog. 

 

 

  

Click index field to 
select whole row 

Click field heading to 
select whole column 

Click corner to select 
whole table 
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• Regions can be cut or copied to the Windows clipboard and then pasted into other applications. 
Similarly, regions from spreadsheets such as Excel can be pasted directly into PedX. Regions can also 
be copied and pasted within PedX, e.g. copy the DOB, sire and Dam fields from one entry to a litter 
mate’s entry. 

3.9 Multiple Open Files 

Within PedX you can have several files open at any time. This will mean that PedX has a working copy of 
each file. You can only operate on one file at any given instant, so to switch between files use the “View” 
menu command. It will list all the files that you have open – to select a particular file just choose it from 
that menu. An example is shown below in Figure 3.3. As can be seen there are three files open within 
PedX, “dogsmpl.bmx”, “catsmpl.bmx” and “cat50.fmx” – the currently selected file has a tick next to it on 
the menu – in this case it is “dogsmpl.bmx”. 

Figure 3.3 

 

3.10 Data Types 

There are five basic data types, i.e. text, date, number, currency, integer. The text type is stored as text, 
however the other three types are stored as a number and are converted to a displayable format 
automatically. 

The list of display options for each data types is as follows: 

Text 

• Normal 

• Photo 

Date 

• Auto - uses the date order and date separator specified in the Windows Control Panel Regional 
Settings 

• dd/mm/yyyy, e.g. 27/01/1956 

• mm/dd/yyyy, e.g. 12/27/1956 

• yyyy/mm/dd, e.g. 1956/2/7 (note month is not padded out to two digits with leading zero) 

• dd Month yyyy, e.g. 7 Feb 1956 

• yymmdd, e.g. 19561227 

• YYMMDD, e.g. 561227. 

• YYYY/MM/DD, e.g. 1956/02/07 (note month is padded out to two digits with leading zero) 

Number 

• 0 

• 0.00 

• 00,000 

• 00,000.00 
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• 0% 

• 0.00% 

Currency 

• $0 

• $0.00 

• $00,000 

• $00,000.00 

Note that the separator used for dates and the currency symbol are both user definable via the Windows 

Control Panel, Regional Settings. 

3.11 Diacritical Markings 

In earlier versions of PedX use of characters with diacritical markings, such as ä, é and ß, resulted in an 
incorrect sort order. 

In PedX these characters have been mapped to their unmodified equivalents.  The modified characters can 
now be entered as such without disturbing alphabetical sort and the modified characters will print to 
pedigree forms, etc. 

As well as the normal shortcuts for entering special characters, PedX allows for them to be entered using 
the following shortcuts (similar to Word2000): 

 

To get these characters Type this, then this 

à, è, ì, ò, ù  

À, È, Ì, Ò, Ù 

CTRL+` (ACCENT GRAVE), the 
letter 

á, é, í, ó, ú, ý 

Á, É, Í, Ó, Ú, Ý 

CTRL+' (APOSTROPHE), the letter 

â, ê, î, ô, û 

Â, Ê, Î, Ô, Û 

CTRL+SHIFT+^ (CARET), the 
letter 

ã, ñ, õ 

Ã, Ñ, Õ 

CTRL+SHIFT+~ (TILDE), the letter 

ä, ë, ï, ö, ü, ÿ  

Ä, Ë, Ï, Ö, Ü 

CTRL+SHIFT+: (COLON), the 
letter 

å, Å CTRL+SHIFT+@, a or A 

æ, Æ CTRL+SHIFT+&, a or A 

ç, Ç CTRL+, (COMMA), c or C 

ð, Ð CTRL+' (APOSTROPHE), d or D 

ø, Ø CTRL+/, o or O 

ß CTRL+SHIFT+&, s 

  

For example, to get the ä character, hold Shift and Ctrl down then type the colon character ‘:’ then release 
all keys and type the letter a. 

A modified character can also be entered into PedX by pressing Alt+n, where n is the numeric value in the 
ASCII Character Set.  The numeric value must be entered from the numeric key pad on the keyboard, not 
from the numeric keys above the alphabet keys. 

Table 4 lists the modified characters that have been mapped to unmodified equivalents in PedX Pro 4, with 
the values for n in each case.  Some currency symbols have been added to this list. 

 

Table 4.  ASCII Values for Diacritical Markings. 

Modified Character ASCII Value Mapped to 

Ç 128 C 
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Ü 129 u 
é 130 e 
â 131 a 
ä 132 a 
à 133 a 
å 134 a 
ç 135 c 
ê 136 e 
ë 137 e 
è 138 e 
ï 139 I 
î 140 i 
ì 141 I 
Ä 142 A 
Å 143 A 
É 144 E 
æ 145 a 
Æ 146 A 
ô 147 o 
ö 148 o 
ò 149 o 
û 150 u 
ù 151 u 
ÿ 152 y 
Ö 153 O 
Ü 154 U 
¢ 155  
£ 156  
¥ 157  
á 160 a 
í 161 i 
ó 162 o 
ú 163 u 
ñ 164 n 
Ñ 165 N 
ß 225 s 

 

3.12 Dialog Bar 

The dialog bar will change appearance depending on what view you are in. 

3.12.1 Grid View 

The dialog bar in the database view is used for modifying data or creating new entries. It contains a combo 
box and three buttons. 

 
The combo will contain the text from the currently selected cell – note this is the cell which is highlighted 
in yellow. To modify this data simply click in the combo and type your corrections and hit the Enter key. 
To replace or delete part of the text, click and drag the mouse across that part of the text in the combo and 
hit the delete key or just type your replacement characters then hit Enter. The left and right arrow keys plus 
the Home and End buttons can also be used for moving the cursor within the edit box. 

The buttons in the dialog bar are as follows: 

DropDown button  
This button is part of the combo and it will only appear when a linked field is currently 
selected, e.g. sire or dam. Click on this button to get a list of linked choices. In the case of sire 
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or dam it will list all names in the Pedigree table. The list will change as you type into the 
ComboBox to match the characters typed. 

Add Record (Equivalent to hitting F5)  
In the database view this will add a new entry in the database. The first field of that record 
will be set to the string in the Edit Box. Hence if you entered “Magdala Sandringham” in the 
Edit Box and hit Add Record then a new entry would be created with this name. 

Find (Equivalent to F9 or Search-Find Key)  
Only operates on linked fields such as sire, dam, owner, country etc. If a name, sire or dam 
field is selected it will find the record which has the name in the combo. If an owner or 
breeder field is selected it will jump to the Contacts table to the entry which has the same 
name as in the combo. 

Single View  Equivalent to Ctrl+S. Switches to Single view. 

Relations View Switches to Relations view. 

Navigator Make the Navigator visible 

3.12.2 Form Design View 

The dialog bar in the design view is used for editing the forms. The font and character size combo boxes 
are used for changing these aspects of text or fields. First select the text or fields (any number can be 
selected) then use the combo box to select the font or size you want. 

The table combo box is used to change the table that a record is tied to. First select one or more records 
then select the table from the table combo. 

The field combo is used to select which field of a table the selected fields should be tied to. 

 

 

 
 

 

Note that for all the combo boxes, the defaults values will be displayed if nothing is selected and if one or 
more objects are selected and they have the same values then the combo boxes will display that, e.g. if all 
selected text is size 13 Arial then the combo boxes will show that. 

 

Font 

Character 

Size 

Field Table 
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4 File Menu 
This section describes the commands available under the File menu. 

4.1 New Database 

Create a new database by selecting New Database from the File menu. A popup menu appears listing the 
available templates (usually DOG and CAT) and also offering a “Browse…” option. Select DOG or CAT 
if appropriate, otherwise click on the Browse option. You will then be asked to select a template file from 
a file open dialog, e.g. DOG.BMT or CAT.BMT. These predefined templates have all the fields setup for a 
particular type of database. 

PedX makes an empty working file and all the operations that you perform within PedX will be performed 
on that working copy, e.g. any changes made to the data will be to the working copy. To create a file on 
your hard disk you must issue the File-Save Database or File-Save Database As commands. 

4.2 New Form File 

When you create a new form file by selecting New-Form File from the File menu, PedX makes an empty 
working file and all the operations that you perform within PedX will be performed on that working copy, 
e.g. any changes made to the form designs will be to the working copy.  To create a file on your hard disk 
you must issue either the File-Save or File-Save As command.  

Forms files - these end “.fmx” and contain a set of individual forms, e.g. pedigrees, show entries. (If you 
want to create a new form rather than a form file use the Form-New command. 

4.3 Open 

When you open a file, PedX makes a working copy of the file and all the operations that you perform 
within PedX will be performed on that working copy, e.g. any changes made to the data will be to the 
working copy – the file that you originally opened is unchanged (until you do a save). An example of the 
File Open dialog box is shown in Figure 5.1. 

Figure 5.1 

 
Since PedX has two types of file (database and forms) you can click on the “List Files of Type:” list box to 
see just one type. The default setting is that both forms and databases are shown. 
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4.4 File Merge Database 

Select the database file to merge in the open file dialog box. The records in the Pedigree table of the file 
will be added to the current database. Note other tables such as Heats / Mates, medical records etc. are not 
added but would not normally be shared anyway. 

Merge works as follows: 

• If a record being added already exists (i.e. a record with the same name exists) it is called a duplicate 
record. 

• If the “Keep duplicate records” option is not set (see View-Options) then duplicate records will not be 
added - instead, if the record being added has data in fields that the existing record does not - then 
those individual fields will be added, e.g. if the incoming data had the sire field filled in and the 
existing sire field of the matching existing record was blank, then that sire data would be added. 

• If the “Keep duplicate records” option is set then duplicate records will be added but the name will be 
altered to make it unique by adding sufficient ‘?’ characters to the end of the name to make it unique. 
Note no data field merging will occur. 

Note this command is only for reading records from another PedX database file. If you are trying to read 
data from another database format, then see Tools-Import CSV. 

Note also that PedX users (but not Pro or Lite) also have the option of using the new Merge Manager view. 

4.5 File Close 

This command simply closes the working copy of the file. If any changes have been made to this copy then 
PedX will prompt you to save the changes. 

4.6 File Save Database / File Save Form File 

At some stage, while you are working within PedX you may want to update your original file with the 
changes you are making to the working copy. This is done by selecting Save from the File menu, and it will 
copy the contents of the working copy to your original file. If you are in the database view, the current 
database file will be saved, if you are in the forms view then the current forms file will be saved. You 
would only save the forms file if you have redesigned any of the pre existing forms, e.g. by moving some of 
the items. 

It is good practice to regularly save your work – say at 15 minute intervals or greater depending on the 
amount of work you have put into changes. This will avoid any significant loss of work if the computer 
should crash for any reason, e.g. power failure. 

If you do not save your file then any changes made during your current work on PedX will be lost when 
you quit. Note if you have changed your working copy and you attempt to quit, PedX will ask you if you 
want to save your changes. 

Note: when you select Save from the File menu, PedX will immediately save your file – there is no dialog 
box.  

4.7 File Save Copy of Database As / File Save Copy of Form File 

As 

The File-Save Copy As commands allows you to save your working copy to a different file. For example 
you could open “SAMPLE.BMX”, optionally make some changes and then save as “MINE.BMX”. In this 
case there will now be two files on your hard disk, “SAMPLE.BMX” and “MINE.BMX”. 

Similarly if you are in the forms view and you had “DOG.FMX” open, then did a Save As 
“MYDOG.FMX”, it would create a new file on your hard disk called MYDOG.FMX which contained 
everything in DOG.FMX plus any changes you had made. 

Note that the name in the title bar will change to the name you selected when you did the Save As and any 
further changes you make – when saved will be saved to this new file name. 

A sample File-Save As dialog box is shown in Figure 5.2. Navigate through the drive and directories as 
described in Section 5.2 then type the name of the file you wish to save to in the text box immediately 
under “File Name”. If the file already exists you will prompted “This file already exists. Replace existing 
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file?”. If you click on “Yes” then the existing file is replaced by your working file, otherwise if you click 
“No” you will be prompted for another file name. 

Remember the File-Save As  commands create a new file each time so any changes which are saved will be 
saved to the new file not the previous file. For example you current file is called BREED.BMX, you make 
some changes then do a File-Save Database As to a file called BREED1.BMX- this causes a second file 
called BREED1.BMX to be created which contains all your data plus changes, while BREED.BMX will 
not have any changes. 

Figure 5.2 

 
 

4.8 Print 

PedX allows you to print from any of the three possible views, i.e. database, forms, forms designer. 

To print the various views just: 

• Select the view first. 

• If in database view select Print Setup from the File and set the paper size and orientation. This is not 
required in forms or forms designer views. 

• Select Print from the File menu or select Print Preview from the File menu. 

In print preview you can see how the page will look when it is printed. 

Note: If more than one cell is currently selected then Print Preview will only show the selected lines. 

 
Any output from PedX should be manually checked to verify its 
correctness. Where possible, always refer to official records.. 

In the case of forms, PedX has an option to fit the print out to the paper size. Hence even if a form has been 
designed for, say A3, it can still be printed on A4 by just using Print Setup to select the A4 size and 
selecting the “Fit To Page” option. 

In the case of database printing, the printout will always be the same size regardless of paper size. To fit 
more columns in your printout select the landscape orientation from the Print Setup menu under File. 

An extra option is available from the database view when printing. It is possible to print just a part of the 
database by selecting a region then from the Print dialog choose Selection under Print Range. 

Also in the database view, if the view is in Filter Marks mode, then only entries marked in the primary 
color are shown on screen, and when printing, only marked entries will be printed. The select region option 
is also available in this mode. 

Note that the database printout will print starting from the left-most column shown on your screen, 
therefore if you have printed out data and it only goes up to the fourth column, you can print the fifth 
column onwards by scrolling the database view to the right until the fifth column is the left-most column 
displayed, then do another print. 
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4.9 Print Setup (Database) 

The database view can be printed in either landscape or portrait orientation or on any size paper which is 
supported by the printer. PEDX does not store the paper size and orientation last used with the database 
view, therefore you should set these before printing. 

4.10 Print Setup (Forms) 

Each form stores its own paper size and orientation therefore you need only do a print setup once for each 
form. 

Figure 5.3 

 
The print setup dialog shown in Figure 5.3 allows you to: 

• change the paper orientation to either landscape or portrait; 

• select the printer to which output should occur; 

• select the paper size - if “User Defined” is selected, the width and height of the paper can be specified; 

• fit the form to the page by selecting the “Fit to Page” check box; 

• make a form which covers many sheets of paper by specifying how many pages horizontally and 
vertically (this rather neat feature would allow you to do a “giant” pedigree which covers many sheets 
of paper). 
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5 Edit Menu (Database, Forms) 
5.1 Undo (Database) 

This command will undo an unlimited number of database commands. Even large and complex commands 
like a file merge can be undone but it will be undone one add/modify at a time hence if the merge added 50 
records you would need to hit undo 50 times to undo the one merge. 

The undo list will be erased if you do a save or rebuild indexes command. 

5.2 Cut (Database) 

Cut is similar to the copy command except that it will clear the selected cells after copying them. Note the 
cut command will not be performed if the region encompasses the name field. To cut a region which 
includes the name field, first copy the region then delete the region. 

5.3 Copy (Database) 

To copy a range of entries and fields to the Windows clipboard first select the region and then select Copy 
from the Edit menu, or just type Ctrl+C, or select the Copy tool bar button. 

Copy and paste can be useful where the same information has to be added to many entries, e.g. after 
setting up your database you may want to add title information – just zip down the database list and paste 
“CH.” into the appropriate cells. 

5.4 Paste (Database) 

The entire contents of the clipboard can be pasted into a particular region by first selecting the cell at the 
top left of the region and then selecting Paste from the Edit menu, or just type Ctrl+V, or select the Paste 
tool bar button. 

The extent of the region to which the paste applies is determined solely by the clipboard data. If, for 
example, seven rows by four columns of data had been copied from, say, a spreadsheet, and then pasted 
into PedX, then a region of seven entries by four fields would be pasted over. 

Note if the selected cell to which you are pasting is the name field then the paste command is disabled. 

5.5 Insert (Database) 

If you choose to insert, then the data on the clipboard is inserted as new records, rather than being pasted 
over existing cells. 

5.6 Insert Picture in Cell (Database) 

This command is simply used to paste the full path name (the file name including the name of its directory) 
of a picture file into a database cell. Selecting this command will cause an Open File dialog box to appear. 
Just browse the directories until the desired file is found, select it then hit OK. An example of a field which 
has been filled in this way is shown in Figure 6.1. 

Figure 6.1 

 
Note that PedX has a sub-directory called “Photos” in your PedX directory (usually C:\Program 
Files\PedX). If you store your photos in that directory then you do not have to put in the full path name - 
just put the name of the file in, e.g. instead of having to put in “C:\Program Files\PedX\Photos\mydog.jpg” 
in the Photo field you can just enter “mydog. jpg”. 
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5.7 Update Cell 

Each entry contains a number of fields called cells. Editing an entry involves updating the contents of a 
cell. To update a cell in the database do the following: 

• First select that cell by clicking on it in the database or forms view – it will then be highlighted in 
yellow. 

• The contents of the selected cell will appear in the Edit Box where it can now be modified. 

• To add text at some point in the Edit Box just click at that point and start typing - you can also use the 
arrow keys and Home, End keys to move the cursor. 

• To delete text in the Edit Box just swipe the mouse across the text to be deleted and hit the backspace 
key. Alternatively insert the cursor immediately after the text to be deleted and hit the backspace key 
for each character to be deleted. 

• The final step is to replace the modified text in the Edit Box back into the database cell by hitting the 
Enter key. Note that when you do this the cell to the right of that cell becomes the new selected cell – 
this makes it easy to keep adding data to consecutive fields. 

Note that cells can be selected by simply clicking on them or by using the cursor keys (up, down, left and 
right arrow).  

It is also possible to delete the contents of the cell quickly. Select the cell then hit Delete. 

 
When linked fields (those which have a foreign key) are changed in 
the database view, PedX will do a quick check to see if a matching 
record exists - if it does not it will ask if you wish to create one. For 
example if you enter a sire and a record doesn’t exist for that sire then 
you will be asked if you wish to create a record for the sire. 

5.8 Clear (Database) 

This command is only available in the database view. It can also be selected by hitting Delete. It causes the 
contents of the currently selected cells to be deleted. If more than one cell is selected, the user will be 
prompted with a message asking to confirm the operation. 

5.9 Change Case (Database) 

This command is only available in the database view. It will change the case of all the data in the currently 
selected area (yellow highlight). The case can be changed to: 

• Lower case - all alphabetic characters will be changed to lower case. 

• Upper case - all alphabetic characters will be changed to upper case. 

• Title case - all alphabetic characters will be changed to lower case, except for the first character of 
each word. 

• Sentence case - all alphabetic characters will be changed to lower case, except for the first character of 
each field. 

This command is useful e.g. when merging another persons data and it is in all upper case - you would then 
simply select the name, sire and dam fields (note these are not contiguous, therefore you would select the 
name field first by clicking on the heading, then change case, then do the same for sire and dam) and 
change the case to title case (the normal). 

5.10 Add Record 

The add record function can be performed from the database or form view. 

To add a record do the following: 

• Enter the name of the record in the Edit Box. 

• Then select Add Record from the Edit menu;  ... OR ... 

• Click the Add Record button from the dialog bar;  ... OR ... 

• Hit the F5 key on the keyboard. 
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Once this is done a new entry appears in the database view with the name that you entered and in its 
alphabetically ordered position. An example can be seen in Figure 6.2. In this example a new entry called 
“American Pie” was added by first typing the entry’s name in the Edit Box and then hitting the F5 key. 
Immediately after this is done PedX will display the new entry in its alphabetic position in the database. 

Figure 6.2 

 
 

 
If you attempt to add an item to the database which has the same 
name as an existing entry, the entry will not be added 

 

 
Entries which have been added will have their name field marked, i.e. 
highlighted. This will occur when the entry was added by Edit-
Insert or by importing or merging. 

5.11 Copy Record 

This command will simply duplicate the currently selected command but will append “(Copy)” to the end 
of the name. Use F6. 

5.12 Delete Record (Database) 

This command will delete all the records in the currently selected region of cells. If, for example, a single 
cell is selected then only the entry containing that cell is deleted (the entire record is deleted including all 
cells). If a range of 10 entries is selected then all ten entries will be deleted. Note that a warning message 
will be issued first to ask if you really wish to delete these records. 

If the database view is in the Filter Marks mode then only marked lines in the selected range will be 
deleted. 

5.13 Calculate Inbreeding (Database) 

An animal’s Inbreeding Coefficient (Wright’s Coefficient, or, F) is a numerical value that responds to the 
presence of common ancestors on both the dam’s and the sire’s side of the animal’s pedigree. The 
Inbreeding Coefficient is expressed as a percentage.  The more common ancestors there are in a pedigree, 
and the closer they are in terms of generations to their descendant, the higher the Inbreeding Coefficient of 
that descendant. 

The Relationship Coefficient (R) estimates the probable percentage of genes passed down from a 
particular common ancestor. 
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PedX 5.0 calculates both Inbreeding and Relationship Coefficients from the command [Edit-Calculate 
Inbreeding].  Both coefficients appear on the 7-generation Family Tree Form and also in fields 44 and 45 
of the Pedigree Table. Note: the Relationship Coefficient is valid only for the last entry for which it was 
calculated. 

 
After selecting the number of generations to use in the calculation and clicking on the “Calculate” button, 
the number of ancestors (within the selected number of generations) is displayed along with the Inbreeding. 
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6 Edit Menu (Design) 
6.1 Copy 

Copies the selected drawing objects to the clipboard. They can then be subsequently pasted into any other 
PedX form. Items can be selected by clicking on them (hold down Shift to add more items to you selection) 
or click in top left of a rectangular area, drag down to the opposite corner and release the mouse button to 
select all items within that area. 

6.2 Paste 

Pastes the selected drawing objects from the clipboard into the current form at the last clicked mouse 
position. 

6.3 Duplicate 

Use this command to duplicate selected drawing entities. This command is very useful for producing an 
array of objects at even spacing because it will offset each duplicate at the same offset as the user 
previously set by dragging. For example, to produce a column of rectangles at an even vertical distance, 
draw the first rectangle then Edit-Duplicate (or Ctrl-D). The first duplicate will be offset by 1mm to the 
bottom left. Drag the first duplicate so that it is offset vertically by the required distance and keep typing 
Ctrl-D for each duplicate. They will be created at the same offset from the previous duplicate. 

6.4 Select All 

Use this command to select all drawing entities. This command can also select all drawing entities of any 
given type, e.g. all lines or all fields. This is done by first selecting the tool corresponding to the entity 
before selecting the Edit-Select All command. 

This command can be used together with the Edit-Lock command to select all types of a given entity and 
then make them temporarily disappear to allow other objects which might be located underneath, to be 
worked on. 

6.5 Delete 

This command will delete the currently selected drawing objects. 

6.6 Align Left, Right, Top, Bottom 

The various versions of this command will align the currently selected objects to the relevant side, e.g. 
Align Top will align the currently selected objects so that all their top edges are in alignment. These 
commands are very useful for tidying up a forms design by keeping relevant fields in line. 

6.7 Align Height, Width 

The various versions of this command will set either the height or the width of all the selected objects to be 
the same. 

6.8 Bring to Front, Send to Back 

This brings the selected objects to the front (or back) of the display order. If the objects are sent to the front 
then they would obscure any objects which appear behind them. If they are sent to the back then they may 
be obscured by other objects. This command is particularly important for setting the order of records where 
one record overlaps another record. The record which is furthest back in the display order (i.e. first to be 
painted) will be the one that a field will belong to. 

6.9 Lock, Unlock 

Lock will cause the currently selected objects to be locked. Locked objects are not visible and cannot be 
selected. The Lock command can be issued any number of times to keep locking more objects. This 
command is useful for temporarily removing objects so that underlying objects can be worked on. Another 
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useful trick is to combine this function with the Edit-Select All command when a tool is selected. This 
causes all objects of the same type as the currently selected tool to be selected and then when locked, to 
disappear. 

The Unlock command will make locked objects reappear. 

6.10 Expressions 

This is covered under the Forms section in the first part of the manual. 
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7 Search Menu 
There are seven find commands available, i.e.Find Similar, Find Key, Find Next, Find Previous, Find 
Mark, Find Replace and Backtrack. All these commands, except Find Mark will perform a search of the 
database based on a search string entered in the Edit Box. If the search is successful then the ‘found’ cell 
will become the current selection (highlighted in yellow).  

All the find commands except Find Replace are also available as toolbar buttons as described in Section 4. 

 
When the find command scrolls to a particular cell, the contents of 
the cell will not appear in the dialog bar. This is to prevent your 
search string from being overwritten.  

 

7.1 Navigate (Database, Forms) 

This command works in either the database or form views. It will bring up a pedigree navigation dialog box 
as shown in Figure 8.1, which is referred to as a “Navigator”. The Navigator is extremely useful for 
entering sires and dams or moving around a pedigree tree by listing siblings, ancestors or offspring of 
selected entries.  

The Navigator is a dialog box which can be used for entering sires or dams, or for certain other linked 
fields - in the same way that the combo in the toolbar works. With the Navigator, if you clicked in say a 
sire field, it will list all names in your Pedigree table making it easy to select from the list and thus enter in 
new sires (or dams). If you click in a show titles field, the Navigator actually lists all possible show titles so 
you could just select one and insert it.  

Linked fields are those that have a choice as defined by a “foreign key”, i.e. they are linked to another field 
in possibly another table. The list of fields and their foreign keys is shown in Figure 6.1. The first column 
lists the table (which contains the field) and the field. The second column lists the table and field that the 
first column is linked to. 

Figure 6.1 Foreign Keys 

 Table-Field Foreign Key Table-Field 

1 Pedigree - Sex Choices-Sex 

2 Pedigree-Sire Pedigree-Name 

3 Pedigree-Dam Pedigree-Name 

4 Pedigree-Show Titles Choices-Show Titles 

5 Pedigree-Obedience Choices-Obedience 

6 Pedigree-Color Choices-Color 

7 Pedigree-Owner Owner-Name 

8 Pedigree-Breeder Owner-Name 

9 Pedigree-Country Choices-Country 

 

Here are two examples demonstrating what the table means: 

• (Item 2 in the table) select the sire field in the pedigree table with the Navigator - it will list all the 
names from the pedigree table; 

• (Item 5 in the table) select the obedience field in the pedigree table - the Navigator will list all 
Obedience data from the Choices table. 

 

The Navigator can be invoked by clicking on a cell containing the entry’s name with the RIGHT mouse 
button (this could be a name or sire or dam cell). Alternatively you can also select the cell first using the 
left mouse button then hit the F2 key or Ctrl+N. 
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7.1.1 Navigator - Docked or Floating 

When the command is invoked the Navigator dialog will appear as shown in Figure 8.1 with the selected 
entry’s name in the combo box. Note Figure 8.1 shows the Navigator as it appears when its floating. The 
Navigator can also be docked by simply clicking in the title bar of the Navigator and dragging it over to the 
left side if the screen. It can be “floated” by double clicking in the title bar or dragging and releasing 
anywhere except the left side of the screen. 

The Navigator looks and behaves differently depending on whether its docked or floating. If its docked it 
will remain visible, whereas if its floating it will disappear after performing a command like 
Insert/Create/Find. Also when floarting it will display command buttosn whereas when docked it will hide 
these under a menu button. 

The Navigator is quite useful in the form view with a five generation pedigree or seven generation family 
tree. The user can click on an empty cell in the tree and enter a sire or dam by picking from the “smart list” 
or navigating the pedigrees using the ancestor, siblings and offspring menu items. 

The dialog box consists of: 

• Edit box - type into here to change the name you are searching on. 

• List box - this lists the result of any search - click on an entry to transfer it to the combo  box. 

• Search menu - Similar, Ancestors, Full Sib, Sire Sib, Dam Sib and Children. 

• Action short cuts- Find, Insert and Create. 

The search performed by the menu items/buttons is as follows: 

• All – lists all records linked to the currently selected field 

• Sire - this will list the sire of the entry in the combo box. 

• Dam - this will list the dam of the entry in the combo box. 

• Similar - this is a “similar match” providing a list of close name matches. 

• Ancestors - list all ancestors of entry in combo box. 

• Full Siblings - list all siblings of entry in combo box who share the same sire and dam. 

• Sire Siblings - list all siblings of entry in combo box who share the same sire. 

• Dam Siblings - list all siblings of entry in combo box who share the same dam. 

• Children - list immediate offspring, i.e. children. 

• Marks – list all marked records. 
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Figure 8.1 Navigator dialog (Floating) 

 
The action shortcuts perform as follows: 

• Find -  exit Navigator and jump to the entry in the pedigree table which is listed in the combo box (you 
can also execute this command by double clicking on an item in the List box). 

• Insert - inserts the name from the combo box into the currently selected field in the database. Access 

this command either via the toolbar button   or by double clicking on an item in the List 
box while holding the Shift key down - useful for quick entry of sires and dams, OR by hitting Ctrl+I. 

• Create  -  creates a new entry with the name that appears in the combo box. If the entry already 
exists it will not be created.  

• Mark – currently listed records will be marked in database. 

7.2 Find Key 

Equivalent to the  button on the toolbar. Finds the record which is linked to the currently selected 
field, e.g. if a sire field is selected and the edit box contains “Almondene Gallant”, PedX will go to that 
record if it exists. 

If the current field is a sire or dam then it will jump to the record for that sire or dam. If the current field is 
the owner or breeder, then it will jump to the Contacts table and to the record for that owner or breeder. 

If no match is found a dialog box with the message “No occurrences of string found” is issued. Some fields 
are not linked - in which case no search will be performed. 

7.3 Find Similar 

Equivalent to the  button on the toolbar. 

The Find Similar command will find the next cell in the database that is a close match for the letters you’ve 
entered. This makes it very useful for finding matches which differ because of spelling or typographical 
errors such as missing letters or re-arranged letters. 
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7.4 Find Next 

Equivalent to the  button on the toolbar. 

This will search the database in the forward direction from the current position, i.e. the currently 
highlighted entry. It searches the name, sire and dam fields for an entry that matches the text in the Edit 
Box. The text only needs to match part of the names, e.g. if the Edit Box contained the text “Mac” then this 
would match “MacSpade”, “MacDowel”, “Bemaced” etc. If it does not find a match it starts searching 
again from the top of the file until it returns to the current position. If no match is found a dialog box with 
the message “No occurrences of string found” is issued. 

7.5 Find Previous 

This is the same as Find Next but searches backward – if no match is found it restarts the search from the 
end of the file and searches backward to the current position. This command can be selected by clicking on 

the  button with the Shift key pressed. 

7.6 Find Mark 

Equivalent to the  button on the toolbar. 

This will search the database in the forward direction from the current position for the next marked cell. 
This can only be in the Pedigree table and it will only look in the name, sire and dam fields. This command 
can be useful in situations where you have marked all unreferenced sires, dams and names and you want to 
step through them to check them. 

7.7 Find Replace 

This command allows the user to find or find/replace a string in either the whole of the current table, or the 
currently selected region. If only a single cell is currently selected then find replace will operate on the 
whole table, otherwise it will optionally operate on the currently selected region (see options later in this 
subsection). If for example you selected on whole column (i.e. field) by clicking in the heading field then 
find replace will only operate on that column (useful for changing data only in specific fields). 

Find Replace is implemented as a separate modeless dialog box (this means you can switch between the 
dialog and the database view by clicking on either - the dialog box will not go away unless you click on the 
Cancel button), as shown in Figure 8.2 and it allows the user to enter a find string and a replace string and 
then to perform one of three possible commands: 

Find Starting from the first cell after the current cell this will find the next occurrence of the 
find string by searching all the fields of the database (note the other find commands only 
search specific fields). 

Replace This will replace the currently found occurrence of the find string with the replacement 
string and then find the next occurrence of the find string as indicated previously. 

Replace All This will search the entire file and replace every occurrence of the find string with the 
replace string . 
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Figure 8.2 

 

 
When the find command scrolls to a particular cell, the contents of 
the cell will not appear in the dialog bar. This is to prevent your 
search string from being overwritten.  

 

 
The Replace All command restarts the search replace mechanism 
hence if you had previously selected the Replace command with the 
same search string then the Replace All command could potentially 
repeat the replacement on that entry, e.g. if you did a Replace of ‘roo’ 
with ‘rooroo’ then did a Replace All the first replace would be 
repeated and become ‘roorooroo’. 

 

 
If the Find Replace operation results in the contents of a name field 
being changed to the name of an already existing entry, the change 
will not occur, e.g. if you change one record with a name field of 
“Brown’s Meg” to “Browns Meg” and a record with the name 
“Browns Meg” already exists then the change will not occur. 

 

There are also four search options: 

Match Case The case of the letters must match if this checkbox is crossed. 

Whole Word If the checkbox is crossed then the find string must be a whole word or words, e.g. if 
searching for “fred” then the following data fields would match “fred hello”, “hello 
fred”, “hello fred again”, but the following would not match “frederick”, “alfred”. 

Regular Expressions When selected it will use regular expressions for pattern matching and 
replacement – this is described in detail in the Users Guide. 

Restrict Search to Selected Cells If the checkbox is crossed then only the currently selected region 
(or range of records and fields) will be searched. You could for example select a single 
column and restrict all searches and changes to that column such as selecting “Titles” 
column and changing UD to UDX. 

Restrict Search to Marked Records If the checkbox is crossed then only those records which have 
been marked will be searched or changed. This is a powerful option because it allows 
quite complex editing options to be made, e.g. you could first mark all entries imported 
from the UK by doing a Mark-Substring on the “Imported” field, then changing say 
“CH” to “UK CH”. 

As mentioned, the find replace dialog is modeless, i.e. you can leave it “floating in space” above the 
database view, move it around by dragging its title bar, and select cells in the database view. Hence you 
could for example start up the dialog box, switch back to the database view, move the selected cell (e.g. by 
clicking on another cell), and then starting up a find or replace. Note find operations will always start from 
the cell following the selected cell. 
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It is useful to understand that the find replace mechanism in PedX 
works slightly differently than a word processor. This is because this 
operation is far more difficult in PedX as the action of changing an 
entry’s name actually causes it to be moved in the database, e.g. 
changing “Dunedain Tupelon” to “Valere Tupelon” causes it to be 
moved forward in the database and hence it could be searched again. 
PedX avoids any potential problems by invisibly marking lines as 
having been searched. 

 

7.8 Back and Forward Track 

These  Browser bar buttons are used to go back to a previously selected record and view 
(or after having gone back, the forward button is enabled allowing you to go forward). When selected from 
the database view it will jump to the last selected record. This command is useful in combination with the 
Navigator for navigating up and down various lines in a pedigree. Note these commands will work even 
when backtracking between tables. 

If you click on the drop down part of the backtrack button it will display a menu of recently selected 
records by name. You can instantly retuirn to one of these records by selecting it from the menu. 

Note that there is a sperate pair of backtrack buttons in the Navigator. These work on a different list of 
records selected within Navigator. 
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8 Mark Menu (Database, Forms) 
This section covers mark commands. These are commands which will place a mark against the name of an 
entry in any combination of the eight available mark colors.The mark colors are red, blue, orange, yellow, 
green, light blue (cyan), purple and magenta. 

The concept of marking is quite powerful. It allows the primary mark color to be selected first - all 
following mark commands will then apply marks only in this color. Marks in other colors will be 
unaffected. 

Marked entries can be seen in the forms, Ped Chart and the database view. An entry which is marked with 
say three mark colors will have those three marks appear as three vertical bars in a row one for each mark 
color. 

Marks will be saved when the database itself is saved. 

The mark commands are useful if displaying marked entries in the forms view. For example, you could 
mark all descendants of an important ancestor and then display the family tree of an entry you are interested 
in and follow the line of descent from that ancestor. 

The database view has a Filter Marks command which will cause only marked records to be visible. Once 
it is in this mode you can also print, in which case only the marked dogs will be printed. You can also copy 
a selection to the clipboard in which case only marked lines in that selection would be copied. This would 
allow you, for example, to select all the offspring of a particular entry and then copy them to the clipboard, 
create a new database and paste them in there. 

8.1 Mark Set 

This will add name marks to the selected records in the currently selected color (red or blue). 

8.2 Mark Clear 

This will clear the currently selected mark color marks from the selected records, e.g. if blue marks are the 
current mark then only blue marks will be removed from the selected records leaving the red marks intact. 

8.3 Mark Invert 

This will invert name marks from the selected entries, in other words, entries in the selected region will be 
marked if they were not and cleared of a mark if they were marked. Note: the inversion only applies to the 
currently selected color, therefore if red is selected and you invert all entries, then entries marked in red will 
be unmarked in red and entries not marked in red will be marked in red, while entries with a blue mark will 
be unaffected. 

8.4 Mark Primary Color 

This selects the new primary color. This is the color that will be used by other mark commands such as 
Mark-Ancestors. 

The drop button of the toolbar button  can also be used for this function. Note if the main part of 
this button is pressed than it will mark only the current selected record in the current primary color. 

8.5 Mark Secondary Color 

This selects the mark color to be used for the logical operations AND and OR as described in the following 

sections. It can also be accessed via the toolbar button drop down . Note that if the main part of the 
button is pressed then it will mark the current record in the current secondary color. 

The toolbar button for both primary and secondary will show the current color selected for each as a solid 
square of color. When PedX first starts it will use red as the primary and blue as the secondary color. 

The primary and secondary mark color buttons can be distinguished by the fact that the primary is on the 
left and the secondary on the right. Also the primary color button has a large solid square of color. 
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8.6 AND Marks 

Equivalent to the  button on the toolbar. 

This will logically AND together the primary and secondary marks to produce primary marked only entries. 
A record with only a secondary mark will have the mark removed, a record with only a primary mark will 
have the mark removed and a record with both a primary and a secondary mark will retain its primary mark. 
To summarise; the only marks remaining will be primary marks on entries which were originally marked in 
both primary and secondary. 

This command is useful for performing complex marking functions, e.g. if you wished to mark all entries 
that were descended from a particular entry and also carried a genetic disease you would first mark in blue, 
mark the descendants, then mark in red and use Mark Substring to mark all entries which contained the 
disease name in their GD field. The final step is to use Mark AND Marks to mark entries which were both 
red and blue. The final result is that only entries which were descended from the selected dog AND which 
had the genetic disease, will be marked in red. 

8.7 OR Marks 

Equivalent to the  button on the toolbar. 

This will logically OR together the primary and secondary marks to produce primary marked only entries. 
All entries with either primary or secondary marks will now be marked in primary.  

8.8 Mark No Match 

This is a great command for finding sire or dam entries for which no matching name field exists, e.g. you 
may have entered the name “Injana Fredas Fanfare” in the dam field of a record but there may be no other 
record which contains this name in its name field. 

The function can also be applied to any field which is linked to another field, e.g. you can apply it to the 
Owner’s field, where it will mark any record which has an Owner not listed in the Contacts table.  

This command is very useful for finding errors in the database, i.e. a sire or dam or name field which has 
been mistyped. 

8.9 Mark Not a Parent 

This command marks entries which were never parents, i.e. are not referenced in the sire and dam fields of 
any other entries. This would for example mark records that were simply not used and thus may be 
mistyped in all sire or dam fields or mistyped in the name field of those records. 

8.10 Mark Range 

This command is used to mark records which have a numeric or date field value within a specified range. 
First select any cell in the field you wish to test, e.g. if marking a range of “Date of Birth”, select any cell in 
that column.  

Depending on whether you selected a date field or a numeric field you will get one of two dialogs, either a 
“Mark Date Range” dialog or a “Mark Number Range” dialog. The date range dialog is illustrated below. 

 
There are three possible range situations: 

• Only mark for field values less than - just enter the value in the “Less Than Field” 
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• Only mark for field values greater than - just enter the value in the “Greater Than Field” 

• Mark for field values within a range (non-inclusive) - enter values in both  “Less Than Field” and 
“Greater Than Field”. 

Some examples of how this command can be useful are as follows: 

• marking entries with a DOB older than a certain date; 

• marking entries with a DOB before a certain date or between a range of dates; 

• marking entries with an inbreeding coefficient greater than a certain amount; 

8.11 Mark Ancestors 

Choose Ancestors from the Mark menu. This will search the entry listed in the edit box for all ancestors 
and mark them.  

8.12 Mark Descendants 

This will display a sub menu offering a choice of 1st, 2nd, 3rd, 4th, All, Male Line, Female Line. Selecting 
1st will cause only 1st generation offspring to be marked, 2nd will cause 1st and 2nd generation offspring 
to be marked and so forth. This command operates on the entry listed in the edit box. 

The Male Line of descent command will only mark direct male to male descent - similarly for the female 
line. 

8.13 Mark Siblings 

This command operates on the listed entry in the edit box. It will display a sub menu offering a choice of : 
Sire Only, Dam Only, Sire and Dam, Sire or Dam. If you select "Sire Only" then only entries which have 
the same sire are marked. and similarly for "Dam Only". If you select "Sire and Dam", then only entries 
which have both the same sire and dam will be marked. If you select "Sire or Dam" then entries which have 
the same sire or dam will be marked. 

8.14 Common Ancestors 

This is a very powerful command (but also a slow command because of the thoroughness of the search) 
which will, for every entry marked in the primary color, follow its ancestry and find if one or more common 
ancestors exist, and then mark them in the secondary color. 

This could be useful for example if you wanted to check if there was in fact a single common ancestor for 
all carriers of a genetic disease - this could be done by first marking the carriers using Mark Substring. The 
carriers would then be marked in red - next call Mark Common - and all of the lowest common ancestors 
will be marked in blue. 

If only one entry is marked in blue then all carriers can be traced back to a single carrier. 

8.15 Clear All 

This command removes all marks from all fields of all entries. 

8.16 Mark Substring 

Click on any cell in the field to search, then enter the string to search for in the Edit Bar and then choose 
Substring from the Mark menu. A dialog appears as shown below, then this function searches the selected 
field in the current table to find and mark all records that contain the string entered in the “Match String”. 
For example if we select the sire field in the Pedigree table and type “Almondene” in the edit box then 
select Mark-Substring, all records whose sire field has an Almondene in it will be marked. 
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This command has many purposes – you could select the genetic disease field, enter CL in the Edit Bar and 
then Mark-Substring to mark all entries that carry the CL disease. If you suspect that an entry may have a 
disease then you can enter the normal acronym for the disease followed by a “?”. A search would still mark 
those entries as they still contain the substring, e.g. an entry with “CL?” would be marked if “CL” was the 
search string.. 

Note that this command will use the “Whole Word Only” and “Match Case” options set via the dialog box 
hence you can make your Mark-Substring command case sensitive. This is useful e.g. when marking 
genetic diseases where the lower case letter is the faulty version of the upper case letter, e.g. aa, aA and AA 
are all different. 

If the search string is empty then this command will mark any empty fields. This could be useful for finding 
records with missing sires or dams. 

This command can also be accessed via the toolbar button  , except that this command specifically 
leaves out the dialog. 

8.17 Mark All Ancestors 

This command will mark the ancestors of all the currently marked entries.  
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9 Table Menu (Database Design) 
The commands described in this section are only available from the Data Design view which can be 

accessed by switching to the Grid view then clicking on the Design button . 

9.1 New 

This command will create a new table and switch the current view to that table. The command will cause a 
dialog to appear as shown in Figure 10.1. Enter the table name and select if the table is sorted or not. Use 
sorting only if the first field in each entry must be unique. For example the Pedigree and Owner tables are 
sorted while the Medical and Show tables are not since there could be multiple entries with the same name. 

Since it is a new table the names of the fields will not be set. The names of the fields can be set by clicking 
in the “Field Name” field of the relevant field in Data Design view. 

Figure 10.1 

 

9.2 Update Database 

Newer versions of PedX may use a different table structure such as different fields or fields located in 
different positions. This command will update all these definitions automatically.  

A file open dialog will appear with a choice of template types, e.g. DOG.BMT or CAT.BMT. 

9.3 Update Groups Only 

The grouping used in Single view is a new feature to PedX and was not present in BreedMate V4 so for 
users upgrading from V4 who want to keep their database design they can use this command to apply the 
new groupings without changing or adding any fields. 

9.4 Delete 

This deletes the current table. Note that the Pedigree table cannot be deleted. 

After the table has been deleted the table will be shown as a “.” (period) in the Database buttons drop down 
menu. This is actually a place holder only - the table really is deleted and if a new table is created it will be 
assigned to the next available “slot” which could be one for a deleted table. 

9.5 Rename 

Used to change the name of the currently selected table. A dialog box will appear to prompt for the new 
name. 
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10 Forms Menu 
10.1 New 

This will create a new form and switch the current view to that form. Enter the name of the form and select 
the type of form – either normal (as for pedigrees, show entries) or dialog or text/HTML. The last combo is 
used to set which button or group the form will be listed under. 

 
The size of the form can be set via File-Print Setup. 

10.2 Delete 

This deletes the current form. Note the Enter Pedigree form cannot be deleted. 

10.3 Rename 

This allows the name of the current form to be changed. 

10.4 Group 

All of the forms are organised into groups on the toolbar. The groups are Dialogs, Pedigrees, Shows, 
Breeding, Reports. This command allows you to move the current form to the selected group 
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11 Format Menu (Design) 
This section describes all of the commands in the Format menu. 

11.1 Line Width 

This command is used for setting the width of lines, rectangles, fields and records (it has no effect on text). 
It is a pop up menu that has a sub menu as shown below: 

 
Select one of the menu items to set the line width, e.g. select 1.0mm to set the line width to 1mm. 

Note you can select multiple entities and then apply this command, e.g. select several rectangles and lines 
then apply the command to set their line width. 

If invisible is selected, then the entity will not be visible in normal (non design) mode. This feature is 
usually only used for fields, links and records which are normally set to invisible. They are sometimes set to 
visible e.g. in the family tree form the boxes are in fact the records. 

11.2 Tools 

This command will choose one of the available tools, as follows: select, text, line, rectangle, field, record, 
link, logo. 

11.3 Rectangle Style 

This command will set the rectangle style to one of normal, shadow, indent, raised, scribe. This command 
is normally only used for rectangles used in . 

11.4 Colour 

The color of an object can be changed by first selecting the objects then selecting a color from the color 
combo box as shown below. 
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12 Tools Menu 
12.1 File Import CSV 

The PedX database file is in a proprietary format, but you can import and export data in a commonly used 
format called CSV format. (Note you can also directly copy and paste between PedX and other Windows 
programs such as Microsoft’s Excel and Word.) 

The CSV format is a Comma Separated Value format which is an ASCII text file which consists of a single 
line for each record. All the fields in that line are separated by commas. The fields are in the same order as 
they appear in the database view. 

 
While the file format is called CSV you can change the separator 
character that is used from comma to any other character by changing 
the “Export / Import Separator” field which appears in the Import 
Files dialog. This is necessary when your data contains commas 
within the fields. In such cases it is typical to set the separator to the 
tilde character “~”. 

Before importing make sure that dates in the CSV file are in the 
correct format, i.e. the same as in your database, e.g. if the database 
displays dates as day/month/year then that’s how they must appear in 
your CSV file. 

PedX automatically handles optional double quotes around each field. 

 

An example of a CSV record is shown below (note it is broken over the line because it is too long to show 
here but in reality it must be a single line) –  

Entry’s Name,M,2/1/91,Sires name,Dams Name,N88888,CH.,CDX.,B/W,Owners Name,Breeders Name,3:3 

Note: where a field is empty, the commas must still appear. Also do not put extra spaces in any of 
the fields. 

The same record but with double quotes would look like this (use View-Options to include double quotes): 

“Entry’s Name”,”M”,”2/1/91”,”Sires name”,”Dams Name”,”N88888”,”CH.”,”CDX.”,”B/W”,”Owners 
Name”,”Breeders Name”,”3:3” 

A CSV file can be read into most spreadsheets, e.g. Microsoft’s Excel. Excel will also let you modify the 
file, reorder fields or entries and modify them. The file can then be written back to disk and imported back 
into PedX. 

To import a file, select Import from the File menu. This will bring up the dialog box shown below: 
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PedX remembers the last separator specified, but this can be changed via the dialog. After clicking on the 
Browse button a File Open dialog box will appear. Select the disk drive, directory and then file that you 
want to read in and click the “OK” button. The order of the fields can be changed using the Field Chooser. 
When satisfied, click on the Import button to read the CSV file in. Note that if an entry being imported 
already exists in the database, then that entry will not be read in. 

Note: Both export and import work only on the current table. 

Note: Entries which have just been added will be marked to allow easy identification. To remove these 
marks select Clear All from the Mark menu. 

12.2 Export Database As CSV 

To convert a copy of the database file to a CSV file, select Tools-Export CSV from the File menu. This 
will give you a dialog box as shown below: 



 Pedigree Explorer 6.0 User Reference 

 37

 
The options are: 

• Export/Import Separator – sets the string used to separate each field. 

• Export field headings – if selected the names of the fields will be output as the first line 

• Only marked records – select this if you only want records marked in the current mark to be 
exported. Useful for exporting only the ancestors of one entry. 

After clicking on the Browse button a File Save As dialog box appears. Select the disk drive, directory and 
then file name that you want to export the CSV data to and click the “OK” button, then click the Export 
button to create the CSV file. The file name should have a “.CSV” extension so from within Excel select 
“.csv” files – the name of your file should appear. Select it then click OK and it will be read in. 

Note CSV files are ‘flat’ files - i.e. they have no structure and therefore cannot accommodate more than 
one table. For this reason only the current table will be exported. To change your current table, use the 
Table menu to select a different table. 

See Tools-Import CSV for more details. 

12.3 Export Custom 

This command is very similar to the Tools-Export CSV command. In fact it actually does generate a CSV 
format file from your database. The big difference is that you can select which fields appear in the export 
and you can even export special fields like “Sire Index”. 

The purpose of this command is to generate database for certain web pedigree programs. Since not all 
programs want data in the same format, the format is user definable. 
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After selecting this command, a dialog appears as shown below: 

 
The dialog needs an “expression” representing the output format. In the example above the expression is 
“[Name], [Sex], %3, %4”. The names in square brackets are the names of fields you wish to appear. The 
special sequence “%3” and “%4” represent the sire and dam indexes, meaning that those fields will be 
replaced by the record number of the sire or dam. The %5 sequence will be replaced with a Tab character. 
You can insert fields to export by using the “Insert Field” combo and special fields like “Sire Index” are 
inserted using the “Insert Special Character” combobox. 

If the “Only export marked records” option is selected then only those records which are marked in the 
currently selected color will be exported. This can be useful if you only want part of your database to be 
used for web pedigrees, e.g. only the ancestors of a certain entry. 

If you are producing files for the Alfirin web pedigree generator then select the “Create DBW/IXW files” 
and the “Create BRW File” options. 

After you click on the “Export” button of the dialog a “Save As” dialog appears. Type in a name and click 
on the “Save” button. A sample of part of the saved file for the above case is shown below. 

Almondene Barandale Heather, F, 9, 8 
Almondene Barandale Lassie, F, 13, 15 
Almondene Beauty, F, 133, 15 
Almondene Beautys Lass, F, 16, 5 
Almondene Black Beauty, F, 613, 12 
Almondene Celtic Beauty, F, 32, 425 

12.4 Export Alfirin 

This command is identical to Export Custom except that all the options have been preset for standard 
Alfirin file format. Note that all fields can still be adjusted before the export – just as for the Export 
Custom command. 

12.5 Export Pedigree Viewer 

“Pedigree Viewer” is a program supplied free by Dr Brian Kinghorn at the University of New England in 
Australia and is available from the following web site http://www-personal.une.edu.au/~bkinghor.  

This function produces a file in the format required by Pedigree Viewer. 
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12.6 Move Fields Left 

This command will move the selected fields left one position. Note that this does not actually change the 
position of the fields in the database - it just changes the display order of the fields within the database 
view. This command can also be executed by hovering the mouse cursor above the left hand third of the 
field heading, waiting until the cursor changes to a left arrow, then clicking the left mouse button. 

12.7 Move Fields Right 

Similar to the previous command except it moves selected fields right. 

12.8 Reset Move Fields 

Resets the position of the fields to the default. 

12.9 Edit Field Color 

This sets the text color of any field. The dialog below appears: 

 
A color can be selected in any of four ways: 

• Click on one of the “Basic colors” on the left side 

• Change the numbers in the Hue, Saturation and Luminance edit boxes, noting that the minimum 
and maximum values are 0 and 255. 

• Change the numbers in the Red, Green and Blue edit boxes with limits as above 

• Graphically select color by clicking in the rainbow panel (this sets the hue and saturation) then 
click in the luminance bar. 

Once a fields color has been set you can optionally show this color in any pedigree or other form and even 
in HTML forms. By selecting the “Show Field Color” option from the combo box on the toolbar in form 
view. 

12.10 Rebuild Indexes 

PedX maintains a number of user definable indexes and hashes for each table. This command regenerates 
the indexes if for any reason they are “out-of-sync” with the data. 
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13 View Menu 
13.1 Database (Forms) 

The database view can be selected from the View menu or by clicking on the View Database tool bar 
button. It will show the database view and scroll to the currently selected entry. 

In the forms view you can also double click on a record to jump to its corresponding entry in the database. 

13.2 Forms (Database) 

This section describes how to display the form for a particular entry. 

To show the form double click on an entry in the database view or select the entry by clicking once on it 
and select Form from the tool bar. The form view is now shown as it would appear when printed, i.e. with a 
page in the background. To view smaller or larger areas of the form select the Zoom In and Zoom Out tool 
bar buttons. Use the scroll buttons to scroll the view horizontally or vertically. 

To return to the database view just double click on an entry in the form view. You will then return to that 
entry in the database. 

13.3 Zoom In / Out (Forms, Design) 

Causes the view to be displayed at a greater / lesser magnification, therefore objects will appear larger / 
smaller. 

13.4 Redraw (Forms, Design) 

Causes the view to be redrawn. The view magnification is not changed. This command is useful for 
clearing up the display of any ‘artifacts’ caused by selecting/deselecting/moving or deleting objects. 

13.5 Set Origin (Design) 

The current X Y position of the mouse cursor is always displayed in the status bar as shown in Figure 14.1. 
The origin (zero, zero point) is initially the top left corner of the page but the set origin command will set it 
to the last point the mouse was clicked at. 

Figure 14.1 

 

13.6 Snap to Grid (Design) 

If snap to grid is selected (it has a tick next to the menu item) then any point selected by the mouse will 
snap to the nearest 1.0mm grid point. If snap to grid is not selected then it will be unsnapped and will be in 
the base units used by PedX forms, i.e. 0.1mm. 

13.7 Freeze Field (Database) 

This command allows a selected group of fields to be frozen so that when scrolling horizontally, these cells 
will not be scrolled and will always remain on screen. The group of fields must be contiguous and must 
include the first field. 

First select a cell in the field which is the rightmost field in the group of fields to be frozen, then select 
View-Freeze Field. For example to freeze the name, sex and DOB fields, select any cell which is in the 
DOB field then select View-Freeze Field. 

Note the name field is always frozen. 

13.8 Options (Database) 

Select this menu item to change some of the display options for the database via the dialog box shown in 
Figure 14.2.  
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Figure 14.2 

 
The options are: 

• Mark New Entries - this option will cause added records to be marked in RED. 

• Ask before creating matching entry – if not selected, the user will not be asked if they want to 
create a matching entry – it will just automatically create one. 

• Report records added – when selected, a dialog will appear after pasting records in using Ctrl-R 
(Edit-Insert Records). 

• Show View Tabs – these are tabs located at the bottom of the window that allow rapid selection of 
views or documents. 

• Default Breed - this is the default breed to be used wherever a breed field occurs on a form and the 
breed field in the database is empty. Normally with dogs only same breeds are kept in the one file, but 
with cats there may be several breeds within the one file so this option allows you to set the default 
breed, but where the breed is different you can enter it in the “Breed” field for that record. 

• Photo Path - this is the location where, by default, photos are stored. If just a single name or path is 
entered then it assumed to be a sub-directory of the folder in which your BMX file reside, e.g. if its 
“photos” then all photos are by default stored in the “phots” sub-directory. If the path is a full path 
then the path is absolute and doesn’t depend on the location of the BMX file, e.g. C:\MyPhotos. 

• Set Gender – Allows setting of what character sequence will be used to indicate male or female. 
Certain commands such as Mark-Incorrect Gender depend on this being correctly set. 

13.9 Options (Forms) 

This isn’t a menu item – it’s a combo box on the toolbar as shown in Figure 13.3. Select from the various 
options listed below. 
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Figure 13.3 

 
• Show Marks as a Colored Background. If this is selected then a record which is marked will be 

displayed with a solid color background corresponding to the mark’s color, i.e. records marked in red 
will appear with a solid red background, those marked in blue will appear with a blue background, and 
those marked red and blue will have a magenta background. 

• Show Marks as Colored Text. If this option is selected, then a record’s mark will be shown as the 
text’s color, i.e. all text in fields belonging to that record will appear with the marks color. For 
example to show all champions in red, just use Mark Substring on “CH” - the champions will then 
appear in red text on the pedigrees (or in fact in any form). 

• Show Repeat Ancestors. Use this option to display up to 32 different mark colors for records which 
appear more than once in a form. Useful for finding repeat ancestors in a family tree. 

• Show Champions in Red. Use this option to quickly show any entry with a title, i.e. Title field non-
empty, in a red color. This means that all text related to that entry will appear in red – not just the 
name. 

• Show Field Colors – Will display fields in their respective colors as set by the Tbale-Set Field Colors. 
This would make it possible to have Titles appear in red, the rest of the name in black and obedience 
titles in blue. 

13.10 Set Grid Font (Database) 

The font used by the database view’s grid can be set using this command. 

13.11 List of Views 

At the bottom of the View menu is a list of all the documents open in PedX. This includes both databases 
and form files. Click on a menu item to switch to that document. This command is useful if more than one 
database or form file is opened. 
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14 Help Menu 
PedX provides context sensitive help. To get help on any menu based command, select the menu 
command, and without releasing the mouse button (this would cause the command to be invoked), hit the 
F1 key. This will bring up the Windows Help application with the PedX help file and display help for that 
menu item. 

14.1 Index 

Invokes the Windows Help application with the PedX help file. It will display a list of PedX’s menus. Click 
on one of these to see a brief description of the menu items (commands) under that menu heading. Click on 
any green colored topic to see further details. 

14.2 Using Help 

Invokes the Windows Help application with Help as the topic. Explains in a generic fashion how Windows 
Help works and how to use it. 

14.3 Tutorial 

This brings up the help file topic for the first tutorial. The tutorial is worth working through to get a good 
basic knowledge of PedX. 

14.4 Register 

Use this command if you wish to regregister this product with a different registration number. For example 
if you have upgrade from BreedMate PRO to PedigreeExplorer you will be given a new registration 
number to unlock the extra functions in PedX. Apart from reinstalling, the only way to get the program to 
use this new number is to use this command. 

14.5 Tip of The Day 

This brings up a dialog box which provides useful tips when using PedX. Includes a check box to enable or 
disable display of the tips when the program is first started. 

14.6 About 

This brings up a dialog box which gives the PedX version and copyright information. 
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15 Miscellaneous Commands 
The previous sections only described commands available from via a menu. This section describes all the 
remaining commands which are not menu accessible. 

15.1 Set Field Width (Database) 

The width of the fields in the database view can be changed using this command. From the database view 
move the cursor so that it is above the right hand edge of the name field whose width you wish to change. 
When the cursor is in the correct position it will change to a double headed east-west arrow; when it does, 
press the left mouse button and drag the mouse. Note a gray line will appear starting from the current 
position of the field’s right margin and will move with the mouse. Release the button when the gray line is 
in the desired position for the right margin of the field. 

15.2 Drag and Drop 

This command provides a quick way of copying the contents of one cell to another cell. 

First select the source cell; it will then be highlighted in yellow. Then click inside that cell, and keeping the 
left mouse button depressed, drag the cursor across to the destination cell. Note the cursor will change to a 
standard cursor with a plus sign. Release the mouse button when the cursor is in the destination cell. 

If the cell you are dragging to is off screen, the grid will automatically scroll when you drag the cursor 
beyond the screen boundaries. Scrolling will occur in at varying speed depending on how far outside of the 
grid area, the cursor is. 

15.3 Adding Fields 

All of the available 127 fields are displayed, though some may be shown with a very narrow width. To use 
any of these fields, first set the width as described in Section 16.1 then enter the field name by clicking on 
the field name cell, entering the name in the Edit Box then hitting Enter. 

15.4 Trial or Proposed Matings 

These are created by making a dummy record and then entering in the sire and dam fields. Typically the 
name of the record would start with a "#” so that all mating records will appear together at the front of the 
table. Use a meaningful name like “#Mating – Fred and Ginger”. 

Having created a record for the mating all the normal commands can be applied to it, e.g. display its 
pedigree by selecting the record and clicking on the Pedigree button and selecting a pedigree from the 
menu OR calculate the inbreeding coefficient of the proposed mating by selecting the record and using the 
Edit-Calculate Inbreeding command. 
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16 Database Tables 
PedX allows for up to 127 tables within a single database file. The tables are currently defined as follows: 

• Pedigree– this contains the names of the various entries in alphabetic order and each entry contains 
such data as sire, dam, date of birth, sex etc. 

• Contacts– this contains details about owner’s or breeder’s name, address, suburb, postcode, phone, 
membership number, club etc. 

• Shows– this contains information related to show results. The fields provided are date, name (of the 
entry), club, show, judge, grading (result), class entered, 1st place, 2nd place, 3rd place, challenge. 

• Litters- this contains information common to a given litter. The fields provided are a unique litter 
name, total born, number culled / died, number fostered. 

• Medical- contains medical / worming events. Basically records the dog/cat, the date, condition, result, 
vet (if applicable). 

• Heats / Mates - used for recording the heats and if applicable mates. 

• Studbook - used to focus on specific entries. It contains details such as head, bone, conformation. 

• Hips / Elbows - used for very detailed information. 

• Choices - used to store possible values for various fields, e.g. lists of show titles, colors, countries. 

• Sales / Disposition 

• Puppy Records 

• Reminders 

• Expenses 

• Breed Survey 

• Vaccinations 

16.1 Pedigree Table (Dog) 

This is the main table in any breed file and it is the only table which differs between the cat and dog 
versions of the database file - only the dog fields are listed here as the cat fields are generally a subset. It 
contains details on entries as follows: 

• Name – the name of the entry. Some older exhibits may have simple names, e.g. Cap. This can make it 
difficult to distinguish other dogs of the same name so where this occurs you can precede the name 
with the owner, e.g. Wilsons Cap. For consistency do not include punctuation marks such as 
apostrophes and hyphens in the name. Also some dogs have exactly the same name but may be the 
second, third etc. – in these cases add “2nd” or “3rd” etc. as appropriate. In some cases it may be 
appropriate to have the name followed by a unique number, e.g. “Cap 2038”. 

• Sex – this must be “M” for a male or “F” for a female. 

• Date of Birth (Date) – the format is not fixed but for consistency should be dd/mm/yy, e.g. 27 August 
1994 would be 27/8/91. 

• Name of Sire – this name should match another entry in the table so that a family tree or pedigree can 
be constructed. 

• Name of Dam – same as for sire. 

• Registration Number. 

• Titles – this is the list of titles the entry has been awarded. The format is not fixed but for consistency 
all titles should be in capitals with no intervening full stops and they should be terminated with a full 
stop. List multiple titles with one space between. For Champions enter “CH”, “US CH.”, “UK CH” 
etc. 
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• Obedience – obedience / agility titles. The format is not fixed but for consistency all titles should be in 
capitals with no intervening full stops and each title should be terminated with a full stop. In the case 
of multiple titles just run them with one space between – e.g. “CD. CDX.”. 

• Color – there is no specific format, but for consistency use the abbreviations commonly used for the 
breed. 

• Gd - Genetic Disease – this is a list of all the genetic diseases, or suspected diseases that an entry 
carries. For consistency use two or three letter abbreviations for diseases and separate them with 
spaces. We suggest that suspected carriers are marked with the disease abbreviation only, known 
carriers are suffixed with a ‘+’ and affected dogs are suffixed with a ‘++’. For example, an entry 
which is suspected of carrying Ceroid Lipofucinosis, is a known carrier of Collie Eye Anomoly, and is 
affected by OCD would have a GD field of “CL CEA+ OCD++”. 

 

 
You can use the Mark Substring command with a search field of 
“GD” and a substring of say “CL” to mark all entries which are 
suspected carriers, known carriers or affected by the CL genetic 
disease. This would show up on the family tree if Mark Shaded is 
selected under View-Options. If the search string was set to ‘CL+’ 
then only known carriers or affected would be marked. If the search 
string was set to ‘CL++’ then only affected entries would be marked 

 

• Owner – the name of the entry’s owner – this information is used on pedigree and show entry forms. 

• Breeder – the name of the entry’s breeder – this information is used on pedigree and show entry 
forms. 

• Hip Score – this will typically be entered as two numbers separated by a colon (“:”), the first number 
is the left hip score, the second is the right hip score. For German Shepherds in Australia this can be 
entered as an “A”. In the US this will be the OFA / Penn Hip. 

• Stud Book. 

• Classification - Often used for German Shepherds, this is the classification given by the Surveyor, e.g. 
CL1. It is recommended that the classification be entered as one word (no spaces) otherwise it may be 
split over a line when printed on a pedigree. 

• Imported - put import information here, e.g. ‘Imp NZ’ to indicate imported from New Zealand. 

• Microchip - the microchip or tattoo number of the entry. 

• Surveyor - this and the following field are used by some breeds, e.g. German Shepherds 

• Call Name or other names by which the entry is known. 

• Country of Origin.  

• Breed - in cases where the breed of an entry may be different for each entry, e.g. Group II cats. 
Normally you would not use this field. 

• Genotype. 

• Notes - private notes which should not appear on a pedigree. 

• Height – typically the height in centimeters. 

• Register - name of the registering body for the registration number of this entry. 

• Certifications - list of certifications obtained, e.g. OFA Penn/Hip, BAER. 

• Comment - a comment field which could be included in a pedigree certificate. 

• Photo - used to store the name of a file containing a bitmap picture of the entry. 

• Eye Color; 

• Blood Type 

• User Field1, 2, 3, 4, 5, 6, 7, 8, 9 - nine user definable fields 

• Points (Number) - challenge points or other points e.g. herding, obedience. 
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• OFA 

• CERF 

• Additional Registration Number 

• Inbreeding Coefficient (Number) - this is the Wrights Coefficient and is a number between 0 and 1 
which indicates the degree to which the entry is inbred. Note that when you call the Edit-Inbreeding 
Coefficient command it will calculate the IC for this entry and all its ancestors. 

• Relationship Coefficient (Number) - calculated for a specific record and will place the degree of 
relationship for each record back to the offspring record that was selected when calculating IC 
(above). The RC is only valid between an ancestor and its offspring if the offspring was the one that 
IC was calculated for. 

• Further user defined fields - note these may get used by future versions of PedX. It is best to use the 
User Defined fields described earlier. 

16.2 Pedigree Table (Cat) 

This is the only table which differs between the dog and cat versions of the database. We have wherever 
possible used the same fields in the same column position and have exchanged dog specific fields with cat 
specific fields, e.g. obedience in dogs becomes Coat Pattern in cats. 

• Name. 

• Sex. 

• Date of Birth. 

• Name of Sire. 

• Name of Dam. 

• Registration Number. 

• Titles 

• Coat Pattern (was Obedience in dog db). 

• Coat Color. 

• Coat Type (was Genetic Disease in dog db). 

• Owner. 

• Breeder. 

• Ear Type (was Hip Score in dog db). 

• Blood Type (was Elbow Score - As for hip score. For German Shepherds in Australia this can be 
entered as a “Z”. 

• Tail Type (was Classification - Often used for German Shepherds, this is the classification given by 
the Surveyor, e.g. CL1. It is recommended that the classification be entered as one word (no spaces) 
otherwise it may be split over a line when printed on a pedigree. 

• Imported. 

• Microchip. 

• Register (was Surveyor in dog db) 

• Pet Name. 

• Country of Origin.  

• Breed. 

• Genotype. 

• Notes. 

• Eye Color (was Height  in dog db) 

• Photo 
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• Temperament 

• Coat Color Genotype 1 Series 

• Coat Type Genotype 

• Genetic Trait 1 

• Other fields are same as for dog starting at User Defined Field 1 


